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1 INTRODUCTION 
A spiral sensor is used to determine the true azimuth of inclinometer casing after installation.  
Installed casing spiral is a function of: 

Manufacturing Process 

During manufacturing, it is extremely important to ensure accurate groove alignment and reduction 
of manufacturing induced spiral.  RST Instruments employs a proprietary, machine broached 
manufacturing technique, that insures RST ABS Inclinometer casing has less than 0.3 degrees of 
twist per 10ft. length (<0.005 Rad/3m). 

Casing Coupling 

In comparison to the conventional separate coupling method, the integral coupling design on RST 
Inclinometer casing results in half the amount of couplings per installation.  Given equal coupling 
tolerance, RST casing has therefore half the coupling induced installed spiral as competing separate 
coupling methods. 

Installation Procedure 

Spiral is typically of concern only in deep installations, however, should poor installation be 
suspected, or installed spiral be of interest, a spiral survey must be conducted utilizing this tool.  
Operation is similar to an inclinometer probe using the same cable and readout instruments, 
however it is necessary to only read one groove set, and not take a second 180 degree reading.  
Two sets of readings in the same orientation can be taken just to ensure repeatability of the spiral 
survey (if required). 

The RST Digital Spiral Probe is designed to compliment the RST Digital Inclinometer System.  In 
situations were excessive spiral is present in the inclinometer casing, it becomes important to correct 
for the spiral in order to have the correct magnitude of displacement in the A and B axes.  Typically, 
spiral surveys are recommended in situations where there are: 

• Deep borehole installations 

• Very precise measurements are required 

• Inclinometer data indicates displacements that are in unanticipated directions 

• Problems occurred during the installation of the casing (i.e. twist was induced in the casing). 

The spiral sensor is connected to the Digital Inclinometer reel just like a standard RST Digital 
Inclinometer Probe.  The RST Digital Software automatically senses the Digital Spiral Probe.  The 
probe is then lowered to the base of the borehole and the survey is performed in 0.5 metre (or 2 ft.) 
intervals depending on whether a metric or imperial system is being used.  Readings are displayed 
on the hand-held Field PC directly in degrees. 

Once the data is collected, it can be imported into RST Inclinalysis Software.  A spiral correction can 
then be applied to the Digital Inclinometer data and plots of the borehole spiral can be created.  For 
further information on Inclinalysis software, please contact RST Instruments Ltd. or visit our website 
at: http://www.rstinstruments.com. 
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Spiral Sensor 

The RST Digital Spiral Probe is made from 100% stainless steel and the rotation is measured by a 
precision digital sensor.  The wheel assemblies on the sensor are the same as those used on the 
Digital Inclinometer Probe, ensuring a precise fit with the casing groove profile. 

The spiral sensor is rugged, waterproof and designed for use in any 60mm (2.36 in.) PVC, 70 mm 
and 85 mm (2.75 in. and 3.34 in.) ABS, or 71 mm and 86 mm (2.79 in. and 3.38 in.) aluminum casing 
as manufactured by RST or others. 

Readout Instrument 

The readout device is an Ultra-Rugged Field PC™, which is included with the RST Digital 
Inclinometer system.  Please refer to the RST Digital Inclinometer Brochure for a complete 
description and specifications. 

Control Cable 

Utilizes the standard RST Digital Inclinometer cable.  As spiral surveys are often performed in deep 
boreholes, the lightweight Kevlar strain relief digital cable greatly eases operation in comparison to 
the thicker more traditional analog inclinometer cables. 

 

 

Figure 1 – Spiral Data Collection Method 
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2 INITIAL SET-UP 
• Connect the spiral probe to cable reel, turn on the reel power and launch the RST Digital 

Inclinometer software on the Field PC (just as you would in performing a normal Digital 
Inclinometer survey).  The software will automatically connect to the Reel and the Spiral 
Probe upon start-up. 

• During the connection process, the RST Digital Inclinometer software will automatically 
sense the presence of the Digital Spiral Probe (this may take a few moments).  Messages 
appearing at the bottom of the main screen will reveal the progress of communication with 
the Digital Reel and Probe.  To ensure the system has connected properly, click on the 
Status button and the following screen will appear: 

 

 

Figure 2 – Digital Probe & Reel Information 
• The serial number in the above screen should reflect the serial number of the Digital Spiral 

Probe (this may take a few moments).  To ensure that the system has indeed connected to a 
Digital Spiral Probe, click on the Calibration tab.  The following screen will be shown: 
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Figure 3 – Spiral Probe Calibration Information 
• The probe length, probe units and probe type should all reflect the properties of the Digital 

Spiral Probe.  The Correction Factor is factory set and eliminates the zero offset of the 
probe. 

• Once connected, select the Site/Borehole you wish to perform the spiral data survey on from 
the main menu. 

• Highlight the borehole name and select Edit Borehole. The following screen will appear: 

 

Figure 4 – Edit Borehole 
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• Set the depth of the borehole to an interval of the Spiral Probe Length.  The spiral probe 
must finish on an interval of its length.  Example:  Suppose your borehole is 30.2 metres in 
depth.  The next closest interval that is divisible by 0.5 metres is a depth of 30.0 metres.  For 
the probe to finish on the last divisible interval (0.5 metres), the starting interval must be 30 
metres. 

 

Note 

It is crucial that the depth of the borehole for the spiral survey is calculated so that it is a 
multiple of 0.5 metres (or 2 feet) and that the spiral probe finishes at a depth which is divisible 
by the probe’s length 0.5 metres (or 2 feet).  This means that the spiral probe may not be able 
to be deployed to the absolute bottom of the borehole, rather the first multiple of 0.5 metres (or 
2 feet).  The Digital Inclinometer Program will provide a warning if a borehole depth is entered 
which is not an even multiple of the probe length. 

 

• Set the measurement interval to either 0.5 metres or 2 feet.  Press OK. 

• The data file format is preset for spiral data, the custom filename can be selected using the 
Reading Data file Options dialog. 

• The spiral data files are tagged with the prefix “SDP_” to help with data file management. 

 

Figure 5 – Reading Data File Options 
• Click on the Readings button on the main menu and the following screen will appear: 
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Figure 6 – Readings Screen 
• The software displays the spiral readings directly in degrees.  Logging the spiral data is 

done in a similar manner as an inclinometer survey. To begin the survey, push Start button. 
The initial position is then measured. Accept button needs to be pressed when in manual 
mode. In Auto Accept mode, the probe will sense movements and the reading will be taken 
automatically without the need to press any buttons. The reading mode can be changed on 
Options screen, shown in Figure 12. 

 

Figure 7 – Detecting Motion 
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Figure 8 – Analyzing Data 
Soon after the motion data is processed, the instrument will display the angle value and 
prompt to save the measurement. 

 

Figure 9 – Accept Reading 
Additionally, the sound can be played after each measurement is taken. This way the 
operator is notified that the probe needs to be moved to the next point. 

Alternatively, if in Auto Accept mode, the motion is detected and data recorded automatically 
without any prompts. 
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Figure 10 – Probe Motion Detected 
After the measured value is accepted or motion detected in automatic mode, the next 
measurement cycle begins and it is repeated until reaching the top of the borehole. 

 

Figure 11 – Accept Next Reading 
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Figure 12 – Spiral Options 
The Save Raw Data and Advanced button are for diagnostic purposes only. It is not recommended to use 
it unless advised by RST Instruments personnel. 

When Sound notification is enabled, the 0 time setting will play the sound after the reading has been 
calculated. The -1 setting will cause continuous sound until manually accepting the reading, or it will play 
until motion is detected in Auto Accept mode. Any other positive value will set the maximum sound 
playing time. 

Note 
The RST Digital Spiral Probe contains similar highly sensitive electronics as the Digital 
Inclinometer Probe.  Make sure to avoid excessive shock to the device.  Always store the 
Digital Spiral Probe in its case when not in use.  Before placing the probe down the borehole, 
ensure to connect it to the system and power it up.  Once powered, the sensor is much less 
susceptible to shock and vibration.  Always keep the probe clean by rinsing the probe with 
clean water.  The use of solvents is not required and should not be used. 
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3 ACQUIRING DATA 
• Carefully deploy the spiral probe to the bottom of the borehole.  Be sure to wait 10 minutes 

to allow the probe to adjust to the temperature in the bottom of the borehole.   

• NOTE: Only one run per hole is required, you do not need to reverse the probe 180 degrees 
and re-run as when taking inclinometer data.  You may however, want to repeat a run in the 
same set of grooves to check data repeatability. 

• As noted in section 2, set up the Digital Inclinometer software logger to log to the entire hole 
at an interval of 0.5 metres (or 2 feet) making sure the survey completes on the last 
interval of the probe length (either 0.5 meters or 2 feet). 

• Press OK and perform the survey by pulling the cable up at 0.5 metre (or 2 foot) increments 
until the last reading is reached.  The inclinometer program will indicate that the survey is 
complete and will save the file. 

• Download the data from Field PC to the computer using Microsoft ActiveSync  

• To use data with Inclinalysis software, the *.csv spiral data file can be imported directly into 
Inclinalysis, once a specific project has been opened (i.e. you must already have an 
inclinometer data file loaded in Inclinalysis before importing and applying the spiral data).  
Please refer to section 5 below. 

• Total spiral of the hole is the summation of all the readings from the bottom to the top of the 
borehole (clockwise is positive). The bottom of the borehole is used as a reference point for 
spiral data collection. 

4 SAMPLE DATA FILE 
The downloaded data file can be viewed using spreadsheet programs, like Microsoft Excel. 
Following is the sample spiral data file collected using Digital Inclinometer software. The file consists 
of the header part containing various spiral probe and borehole details, and data part. The data 
section has five columns. First column shows where every measurement was taken. The next two 
columns contain the actual measurements in degrees and cumulative value. 

 

Figure 13 – Total Spiral of the borehole 
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The clockwise turn results in positive spiral when pulling the probe up during borehole survey. When 
cumulative spiral is positive as on sample file, the borehole tubing appears twisted counter-clockwise 
when looking down the borehole. 

 

 

Figure 14 – Sample Spiral Data 
The total Spiral for the above data file is 0.7 degrees. 
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5 APPLYING SPIRAL IN INCLINALYSIS 
Under the Borehole Menu select Add/Remove Borehole Files… browse for the *.csv spiral file (the 
filename will contain SDP tag) you created on the Field PC.  This file contains the spiral survey.  
Press Apply and the borehole data will be automatically corrected for spiral.  Confirmation of the 
spiral correction appears in the top right of each plot:  Spiral Correction: Enabled. 

6 APPLYING SPIRAL IN GTILT PLUS 
• Convert spiral data file to TWI format using Spiral File Format Converter utility available on 

Inclinalysis installation CD. 

• Under the File menu, choose Load to load the borehole you are interested in applying the 
spiral correction to. 

• Under the File menu, choose Import, and select TWI File from the drop-down list.  Navigate 
to your spiral data file, and press OK.  GTilt Plus will automatically import the file into the 
current project. 

• To apply the spiral correction, under the Set menu, choose Apply Spiral Correction. 

• If you wish to edit the spiral data, under the Edit menu choose Spiral… 

 

7 CONTACT US 
For sales information contact: sales@rstinstruments.com 

For technical support contact: rst_support@rstinstruments.com 

Head Office: 

200-2050 Hartley Ave. 
Coquitlam, B.C. 
Canada V3K 6W5 
 
Our office hours are:  8:30am – 5:00pm PST 

Monday – Friday (excluding holidays) 
 

Telephone:   604-540-1100 
Facsimile:   604-540-1005 
Toll Free:   1-800-665-5599 
Website:   www.rstinstruments.com 

 


